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SECTION 1  
GENERAL 
INFORMATION Congratulations! You have purchased the System Administration Terminal

(SAT) End-User program for the Electra Elite Key Telephone System. The
SAT End-User is a user-friendly Windows application that allows the user
to program and configure several features of the Electra Elite KTS from
the PC environment.

This application allows the customer to change certain end-user based
parameters, such as:

� All Call Page

� Alphanumeric Display

� Attendant Add-on Console

� Automatic Day/Night Switching Time

� Barge-In {Privacy Override}

� Bilingual LCD Indication

� Customized Message

� Delayed Ringing

� Direct Station Selection DSS

� Distinctive Ringing

� Electric Volume Control

� Flexible Line Assignment

� Flexible Ringing Assignment

� Flexible Timeouts

� Full Handsfree Operation

� Handsfree Answerback

� Headset Operation

� Internal Voice/Tone Signaling
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� Internal Zone Paging (Meet-Me)

� Music On Hold (MOH)

� Night Transfer

� Off-Hook Ringing

� Ringing Line Preference

� Speed Dial Station

� Speed Dial Stored Characters

� Speed Dial System

� Voice Prompt Selection

It is no longer necessary to call an authorized NEC technician to program
these basic system features. Meeting the requirements of a company’s
day-to-day communications needs just got easier!

Simply connect a SAT End-User PC to the KTS via direct or remote
connection, make the programming changes in SAT, upload the changes
from SAT to the KTS, and exit. It’s that easy!

� SAT End-User runs on a PC with Windows 95/98, and connects to
the Electra Elite KTS either directly (using the serial cable included
or remotely using a modem. 

• Direct Connec tion  - this method is used when the user is at the
KTS location.

• Remote Connection  - this method is used for convenient system
programming when the KTS is located at a remote site.
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SECTION 1    
PC REQUIREMENTS This manual provides detailed information for programming using the

Electra Elite System Administration Terminal (SAT) End-User software. 

PC requirements:

� Pentium Processor 

� Microsoft Windows 95/98 operating system

� At least 13 MB of free hard disk space.

� Unused PC serial communication port 

� MNP Class 4  or V.42 bis modem (if remote programming is required)

SECTION 2  
FEATURES OF PC 
PROGRAMMING Some of the features of PC programming include:

Wizard – allows a user to select a feature using wizard.  Wizard prompts
the user to program the necessary system data items associated with the
feature.  When wizard is selected, a tabbed list of information is provided.

(For a detailed discussion of wizard, refer to Section 5 Wizard on page
2-4.)

System Data Upload/Download – allows system data to be transferred
from/to a personal computer to provide backup of data.
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SECTION 3  
SOFTWARE 
INSTALLATION 3.1 Installing Electra Elite System Administration Terminal

(SAT) End-User Software  

1. Insert the SAT setup disk 1 in your floppy drive.
(If installing the CD ROM version, insert the Setup C  in the
CD ROM drive.

2. Click the Windows 95/98 Start  button.

3. Select Run .

4. Enter a:\setup.exe  and click OK.
(If installing from CD ROM, enter the letter of the CD ROM
drive.)

5. Follow the instructions on the PC installation program.

6. To start the SAT End-User program:

• Click the Win 95 Start  button.

• Select PROGRAMS, NEC Electra Elite SAT fo
End-User. 

• Click Elite System Administration Terminal (SAT
End-Use .

• Enter the password. The default password is
PASSWORD  (in upper case letters).

Important: Consult an authorized NEC technic ian to
equip the KTS for SAT programming.
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SECTION 4  
USING SAT When you first begin SAT End-User, all the buttons and menu items are

disabled (grayed out) – except for these menu items: 

COMMUNICATIONS/CONNECT/SETUP

1. Select COMMUNICATIONS/SETUP/PC SERIAL POR .

2. Choose the PC COM Port that is connected to the KTS. The serial
cable provides a direct connection to the KTS, while a modem
provides for a remote connection. 

3. Set up the baud rate  and line settings .

4. For a direct connection , install the serial cable (provided) from the
PC serial port selected in Step 2,  to COM1 on the KTS.

  For a remote connection , when the KTS is at a remote location,
connect a modem to the SAT PC. See an authorized NEC technician
for configuring the KTS for remote connection.

5. Select COMMUNICATIONS/CONNECT, and choose either DIRECT
or MODEM CONNECTION.

6. Enter a password if the KTS requires one. See an authorized NEC
technician for password information.

7. Click the CONNECT or DIAL  button, depending on the type of
connection.

8. Once a connection is established, SAT will automatically perform a
complete download of all system data from the KTS to the PC.

9. When downloading is completed, all the menu items and buttons are
enabled. Begin programming the features using the various menu
items in SAT.

10. Complete programming. Select COMMUNICATIONS/UPLOAD and
press the Start button to upload all of the changes and programming
to the KTS.

Important: To enable the menu items, you must first
connect to the KTS using the following p rocedure:

SAT End-User cannot save any data to the PC hard disk.
When closing SAT End-User, all programming and
changes are cleared from the PC.
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SECTION 5  
WIZARD The wizard organizes system data assignments for programming

individual features.  When the user selects wizard, the system provides a
tabbed list of information related to the selected feature.  

Wizard can be accessed by using the wizard button from the toolbar or by
selecting Wizard  from the File pulldown menu.      

When wizard is displayed, the user can select any feature from the list o
can begin entering letters of the feature name.  As the name is being
entered, Quick Search finds the matching letters and highlights the match.  

Figure 2-1  Selecting Wizard for a Feature

Select from the toolbar.
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When a feature is selected, all system related data items for that feature
are presented in sequence.  Enter the required values in the current tab
and click next to advance to the next tab.  Click back to go to previous tab.
In Figure 2-2 Sample Wizard, the Flexible Line Assignment feature is
selected.    

    

Figure 2-2  Sample Wizard

Tab Count
(for the selected 
feature wizard)

NextBack
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SECTION 6  
PROGRAMMING 
SCREENS Main Menu

When the SAT software program is launched, the first screen that is
displayed is the Main Menu screen.  This screen allows the user to access
the options used to program the Electra Elite system.  Figure 2-3 Electra
Elite System Administration Terminal Software Screen Samples shows the
menu and describes the layout.  

Pulldown Menu

Pulldown menus are available for each function involved in programming
the Electra Elite system.  To access the data associated with the function,
click on the function name on the Main Menu.  Some of the options on the
initial pulldown menu offer several selections.  An arrow to the right of the
option name indicates additional selections are available.  Refer to Figure
2-3 Electra Elite System Administration Terminal Software Screen
Samples for an example of a Pulldown Menu.  

System Data Screen

When an option is selected from a pulldown menu, a screen is displayed
that allows the user to program data for the function selected.  Figure 2-3
Electra Elite System Administration Terminal Software Screen Samples
shows an example of a System Data Screen.  This screen indicates three
tabs. The tabs indicate system data items that are grouped together for
programming. The active tab group is indicated by a box around the tab
title. To access another tab group, press the tab or use the keyboard
shortcut.  Keyboard shortcuts are displayed at the bottom of the screen in
the Information Bar.    
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Figure 2-3   Electra Elite System Administration Terminal Software Screen Sample

Pulldown Menus

Toolbar

Help
Accesses help 

information.

Pulldown Menu
Make selections by clicking on 
an item.  The associated screen 

is displayed.

The arrow indicates additional 
information is available for this 

option.

Tab Groups
The active Tab Group is 

indicated by the darkened box 
surrounding the tab name.

System Data Item 
Screen

Pulldown Menu

Main Menu

Information Bar 
indicates 
Keyboard 
Shortcut.

Connection Status
Indicates whether the data 
path is connected to the 

Electra Elite system.
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SECTION 7  
TOOLBAR Several icons are provided to allow the user to navigate the program.  The

icons in the toolbar are explained in this section  The availability of the
individual tools depends on the activity the user is performing.  When the
icon appears shadowed, the tool is not available.  When the icon is dark,
the tool is available.  Refer to Figure 2-3 Electra Elite System
Administration Terminal Software Screen Samples for an example.      

Accesses the Job Specifications printing option.

Accesses the wizard for individual features. The F10 
special function key provides a shortcut to this 
wizard.

Sets the defaults for all  items on the open tab. 

Sets the defaults for the individual system data items 
(on the screen the default is set for the item where 
the cursor is blinking).

Allows data items to be copied between ports. The 
F3 special function key provides a shortcut to this 
feature.

Allows values between two ports to be swapped. The 
F5 special function key provides a shortcut to this 
feature.

Allows the user to undo the current edits and return 
to the previous editing operation.

Allows the user to return to the previous editing 
operation. The F11 special function key provides a 
shortcut to this feature.

Accesses Quick Search.  Quick Search provides a 
detailed list of system data items. The F8 special 
function key provides a shortcut to this feature.
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Returns to the previous tab group. The Shift + F6 
special function key provides a shortcut to this 
feature.

Advances to the next tab group. The F6 special 
function key provides a shortcut to this feature.

Displays the help contents for the Electra Elite SAT 
End-User software program. The F1 special function 
key provides a shortcut to this feature.

Scrolls up displaying the previous page.

Scrolls down displaying the next page.

Advances to the first page.

Advances to the last page.

Brings up the Connection dialog box. The F7 special 
function key provides a shortcut tot his feature.
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SECTION 8  
ELECTRA ELITE 
PULLDOWN MENUS This section explains each of the pulldown menus that are available in

SAT software.

File

The File pulldown menu provides options for basic file management.    

Wizard
Accesses the Wizard.  Wizard is available for every feature offered in the
Electra Elite system.  Wizard provides all of the information necessary to
program a feature.  All of the system data items necessary fo
programming the feature are grouped together.  The user can press the
appropriate tabs to access system data and make the necessary changes.

Change Password
Allows the user to change the SAT password.

Figure 2-4   File Menu
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Print
Provides two print options: Job Specifications and Designation Labels
(requires a standard inkjet or laser printer). 

When Job Specifications is selected, a menu is displayed.  There are three
options for printing the Job Specifications:  printing a family (group) such
as system-wide, trunk group, or tenant, printing a range of Memory Blocks,
or printing an individual Memory Block.

Designation Labels

SAT End User version does not support exporting data to the DESI Label 
printing software. This menu item is disabled. However, if you chose to 
install DESI during SAT installation, you can still run DESI separately by 
clicking the Windows 95/98 START button, and then selecting:

PROGRAMS/DESI for Windows/DESI

Print Setup
Allows access to the printer setup screen. This allows the printer
configuration to be modified.

Exit
Exits the programming software.  If changes were made, the technician is
prompted to upload the changes before the program shuts down.
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Edit

The Edit pulldown menu allows files to be edited, swapped, defaulted, o
copied.  

Undo
Allows the user to undo current edits and return to the previous editing
operation.

Copy
Brings up the copy screen. This allows port information to be copied from
one port to another.

Swap
Allows values between two ports to be swapped.

Set Default
Defaults to the current field where the cursor is positioned.

Set Default All
Allows the user to set all values to default on the open tab.

Quick Search
Allows the user to search the Memory Blocks by Memory Block Number,
Memory Block Name, or Tab Name.  After the search method is specified,
a list is provided.  The user can scroll through the list and click on the
desired Memory Block.  System data can then be modified as necessary.

Figure 2-5   Edit Menu
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Basic

The Basic pulldown menu allows access to basic end-user programming
items. 

� Some menu items may be disabled if the appropriate hardware is not assigned, 
or a dependent data item is not set.  

Terminals
This option allows the user to assign the terminals to the system.  Several
selections are available with this option.

� System Wide

� Station Base

� Multiline

� DSS/BLF

CO/PBX Trunks
This option allows user to program system data related to trunk
assignments.

One selection is available with the System-Wide option.

Figure 2-6   Basic Menu
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Intercom
This option allows the technician to program system data related to
intercom assignments.

Speed Dialing
This option allows data related to system and station speed dialing to be
programmed. 

System Timers
This option allows the user to change the Call Forward – Busy/No Answe
and CO/PBX incoming Ringing Alarm tone. 

Forced Account Codes
This option allows the user to assign account codes.
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User

The User pulldown menu allows access to system data items related to
speed dialing.   

Speed Dialing
This option allows the user to program Speed Dial memories for each
Multiline Terminal in the Electra Elite system.

Figure 2-7   User Menu
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Communications

The Communications pulldown menu allows access to system data items
relating to direct and remote connections to the Electra Elite system. 

Connect
This option allows the user to connect to the Electra Elite system.

Disconnect
This option allows the user to disconnect from the Electra Elite system.

Upload
This option allows the user to upload programming changes and
configurations to the KTS.

Download
This option allows the user to download the current Electra Elite
configuration.

Verify
This option allows the user to compare the configuration programmed in
the KTS with that of the PC.

Setup
This option allows the user to set up the PC serial port. This is the serial
port connected to the KTS.

Figure 2-8   Communications Menu



Electra Elite Issue 3

SAT End-User Manual 2 - 17

Help

The Help pulldown menu allows access to online help. 

Using Help
This option provides access to the help topics window that describes how
to use the help function.

Contents
This option provides access to the help topics that are available for the
Electra Elite System Administration Terminal system.

Help Topics
This options provides a list of help topics.  The user can bookmark topics
that they may want to refer to again.

Show MB Numbers
When enabling this option, the memory block number is displayed above
the cursor, when positioning the cursor over a data field.

About
This option provides information about the System Administration
Terminal (SAT) End-User software.

Figure 2-9  Help Menu
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